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Disable Find My Mac by Resetting NVRAM
by Adam C. Engst

Find My Mac is an iCloud-based service that enables you to discover the location of a lost Mac, lock it, 
or erase it remotely. However, it turns out that it’s easy to disable Find My Mac, which could be bad 
news if your Mac is stolen or good news if you’re dealing with an old Mac that wasn’t properly reset.

The two main reasons to enable and use Find My Mac are to help recover a lost or stolen Mac and to 
eliminate the worry of misplacing it around the house. For most people, it’s a no-brainer — just open 
System Preferences > iCloud and select the Find My Mac button. The main downside is that if you’re 

concerned about your privacy, Find My Mac opens up an avenue by which you could conceivably be 
tracked.

Finding a Lost Mac -- Should your Mac go missing, you can log in to the iCloud Web site to deal 
with it. Click Find iPhone there, and then select the Mac from the menu at the top to see the Mac’s 
location on a map. A box in the corner shows your Mac’s battery level, lets you play a sound in case it just 
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Announcements

Annual Pizza Party!
Please join us at our annual SMMUG Pizza Party (along with soda and cake) to celebrate 
SMMUG’s 30th anniversary on August 8th. This is social meeting, and there will be no program to 
interrupt the fun and socializing. As always, the pizza and soda are free to club members, but you will 
have to pay for any alcohol drinks that you order.

The party will be at Fargos at 2910 E Platte Ave., which is on the north side of Platte, just east of 
Circle. The party starts at 6:00 and runs to 8:00 pm. Ask for the SMMUG party when you enter the 
front door. 

Club News
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DOOR PRIZE WINNERS

For The July 2016 Meeting
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slipped between the couch cushions, lock it with a passcode (to prevent it from being erased) and display a custom message, or wipe it remotely 
yourself. You can also use the Find My iPhone app in iOS to perform the same tasks.

Unfortunately, Find My Mac requires that the Mac be powered on and connected to a Wi-Fi network, which means that anything you try to 
make happen on a lost Mac may be delayed or never occur at all. Plus, since Macs lack GPS chips, the reported location may not be all that precise 
even when a Mac can be located. At least Macs with solid-state storage and Power Nap turned on can report their locations while sleeping, which 
isn’t true of Macs with hard drives.

There is one other problem that my friend Will Mayall alerted me to recently, which is that resetting NVRAM disables Find My Mac. Will 
discovered this on his own, but it turns out that others have run across the same fact over the past few years, as evidenced by a quick Google search. 
In essence, Apple stores the Find My Mac data in NVRAM, which is good for keeping it around even if the hard drive is removed, but bad in the 
sense that it’s easy to reset NVRAM — just restart while holding down Command-Option-P-R. A quick test confirmed the problem in OS X 
10.11 El Capitan, and nothing has changed in the public beta of macOS 10.12 Sierra.

The only way to prevent Find My Mac from being disabled is to set a firmware password, which you must enter whenever you start up from a 
disk other than the usual startup disk. Plus, if you try to reset NVRAM, you’re prompted for the firmware password, and when you enter it, the 
Mac instead boots into Recovery mode. In fact, when you lock your Mac via Find My Mac, what it’s doing is setting a firmware password.

Don’t set a firmware password without understanding the ramifications, though. If you forget your firmware password, regaining the use of the 
Mac will require a service appointment at an Apple Store or an Apple Authorized Service Provider, and you’ll have to bring an original receipt or 
invoice as proof of purchase. I recommend setting a firmware password that you’ll remember easily — and write it down somewhere safe as well.

Disabling Find My Mac Intentionally -- Now imagine that you’ve just bought a used Mac on eBay, and the previous user didn’t disable Find 
My Mac. Although that was most likely an oversight, that setting would enable them to lock or erase the Mac at any time, so you’ll want to turn off 
Find My Mac yourself. Resetting NVRAM will do the job without having to ask for help from the seller.

For Mac sysadmins who are getting multiple Macs back from users — graduating students or departing employees, perhaps — who may have 
turned on Find My Mac, resetting NVRAM from the keyboard for each Mac might be onerous. Happily, there is a command-line workaround 
published by Mac sysadmin Clayton Burlison — just enter these two commands or make them part of your imaging script:

nvram -d fmm-computer-name   
nvram -d fmm-mobileme-token-FMM 
It’s a little distressing that Find My Mac is so easily circumvented, but at least setting a firmware password addresses the problem for those who are 

concerned. Ideally, Apple would tweak things in Sierra so the Find My Mac data was stored in both NVRAM and on disk, perhaps in the Recovery 
volume, so neither resetting NVRAM nor booting from another disk would be sufficient to disable it.

Firefox Filters More Uses of Flash
by Glenn Fleishman

The Mozilla Foundation, makers of the Firefox browser, said in a blog post that in August 2016 it will start filtering large categories of Flash 
usage that aren’t beneficial for users in order to reduce crashes and improve battery life on laptops. As the year goes on, Firefox will clamp down on 
more kinds of Flash content, and next year it will require that users approve playing any Flash content with a click. These moves are part of a trend 
by all browser makers to deprecate Flash, which is buggy and remains full of security holes.

Like other browser makers, Mozilla claims that loading less Flash content improves security, increases battery life, reduces the time to load and 
render pages, and generally makes Web pages more responsive. Along with its other failings, Flash has long been a CPU hog.

Mozilla bills this as blocking “certain Flash content that is not essential to the user experience,” by which they mean several types of tracking 
mechanisms used by advertisers and ad networks. Because the use of Flash for video has been so heavily reduced, with YouTube, Facebook, and 
others switching to HTML5-based video delivery for modern browsers, advertisers’ use of Flash for tracking and showing videos embedded in ads 
may be the only Flash that most users encounter on a regular basis.

Mozilla notes in a linked code repository that it blocks two kinds of Flash uses for objects that are 5-by-5 pixels or smaller: fingerprinting and 
supercookies. It estimates these two changes will reduce Flash-related crashes by 10 percent, an enormous amount across all Firefox users.

Fingerprinting uses a Flash command to retrieve a list of all installed fonts, which is one method that advertisers use to identify a browser even 
when someone has taken steps to not be tracked.

Supercookies are far worse: they store identifying details in a Flash object that isn’t removed when browser cookies and other tracking 
information are deleted; these Flash objects may even persist across private-browsing sessions. Supercookies often check to see whether a browser 
cookie has been removed and, if so, they “respawn” the browser cookie from an internal cache.

There’s no legitimate reason for users to want browsers to tolerate Flash-based fingerprinting or supercookies, although blocking Flash for these 
purposes only reduces such tracking. Fingerprinting can still be carried out using JavaScript and even CSS, and supercookies can use JavaScript and 
various HTML5 storage and Web server page tagging techniques.

Later this year, Firefox will stop allowing Flash to determine whether a given piece of content on a Web page is visible, another element of ad 

https://mayallit.wordpress.com/2016/07/09/resetting-mac-nvram-disables-find-my-mac/
https://mayallit.wordpress.com/2016/07/09/resetting-mac-nvram-disables-find-my-mac/
https://www.google.com/#q=nvram+%22find+my+mac%22
https://www.google.com/#q=nvram+%22find+my+mac%22
https://support.apple.com/en-us/HT204063
https://support.apple.com/en-us/HT204063
https://support.apple.com/en-us/HT204455
https://support.apple.com/en-us/HT204455
https://clburlison.com/find-my-mac/
https://clburlison.com/find-my-mac/
https://blog.mozilla.org/futurereleases/2016/07/20/reducing-adobe-flash-usage-in-firefox/
https://blog.mozilla.org/futurereleases/2016/07/20/reducing-adobe-flash-usage-in-firefox/
https://github.com/mozilla-services/shavar-plugin-blocklist
https://github.com/mozilla-services/shavar-plugin-blocklist
http://akademie.dw.de/digitalsafety/your-browsers-fingerprints-and-how-to-reduce-them/
http://akademie.dw.de/digitalsafety/your-browsers-fingerprints-and-how-to-reduce-them/
http://www.fightidentitytheft.com/blog/new-breed-super-cookie-defies-removal-almost
http://www.fightidentitytheft.com/blog/new-breed-super-cookie-defies-removal-almost
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tracking. (If someone can’t see an ad, has it truly been served?) An HTML-based alternative will be made available in Firefox when it disables the 
Flash version.

Finally, in 2017, Mozilla will switch from Flash playing by default to requiring a click for approval.
Mozilla’s steps parallel those taken by other desktop Web browser makers. Apple’s WebKit team said in June 2016 that macOS 10.12 Sierra 

won’t reveal to a Web server what multimedia plug-ins it has in order to force sites to deliver HTML5 by default. If a site can’t send HTML5, Safari 
will show the visitor a click-to-play option for Flash. (This is separate from the excellent ClickToFlash and ClickToPlugin extensions available for 
Safari.)

Google made a similar announcement about Chrome in May 2016. The Chrome browser will report that Flash is available only to servers in 
the top 10 most-visited domains worldwide that serve any Flash content, currently including YouTube, Facebook, Yahoo, Microsoft’s Live.com, 
Amazon, and Twitch. Users can also whitelist Flash.

Microsoft isn’t as committed to reducing and ultimately eliminating Flash as the other three major browser makers, and its plans have no impact 
on iOS and Mac users. However, it intends to isolate Flash in future updates to Internet Explorer by “pausing unnecessary content,” which may 
refer to Flash used for tracking, auto-play video, and other ad-related purposes.

Unfortunately, some misguided and outdated Web sites continue to rely on Flash, and this set might include online services you have to use for 
work, banking, or managing health-care issues. Hopefully their reliance on Flash will be short-lived, since every step browser makers take to reduce 
Flash’s use further prods laggard sites to get with the times and give up on Flash.

Walmart Pay Is Better Than You Might Expect
by Josh Centers

The Walmart-led MCX consortium and its Apple Pay competitor CurrentC may be dead in the water (see “CurrentC Out of Juice,” 17 May 
2016), but the retail behemoth hasn’t abandoned the dream of running its own mobile payment system. Walmart Pay, in beta since December 
2015, is now available throughout all 4600+ stores in the United States via the free Walmart app for the iPhone.

Unlike Apple Pay, which uses wireless NFC technology, Walmart Pay takes its cue from the CurrentC playbook, using QR codes that you scan at 
checkout with the iPhone’s camera. Surprisingly, this isn’t as clumsy as it sounds, and unlike CurrentC, which insisted on linking directly to your 
checking account, Walmart Pay connects with a credit card, debit card, or Walmart gift card.

Before I explain how to set up Walmart Pay, you might wonder why you’d want to use it. Here are a few reasons:
• The Walmart app stores your receipts when you use Walmart Pay, which saves on paper and helps with record keeping.
• It serves as a backup payment method in case you forget your wallet.
• The slow scanning of chip-based credit cards gets on your nerves. Walmart Pay isn’t any faster overall, but you don’t have to wait to retrieve your 

card from the terminal.
Setting Up Walmart Pay -- Setting up Walmart Pay is 

straightforward, but you’ll want to do so before heading to 
the store.

Open the Walmart app, and tap the Walmart Pay square 
in the Shop tab. On the next screen, tap Set Up Walmart 
Pay. Then you’ll either need to log in to your Walmart.com 
account or create one. Here’s an impressive detail: the app 
integrates with 1Password, so 1Password users can tap an 
icon to autofill the Walmart login credentials.

Next, you’ll need to add a payment method. If you already 
have a payment method linked to Walmart.com, you can 
select it and tap Use This Card & Continue. Otherwise, 
you’ll need to enter your information from a credit or debit 
card. After that, you also have the option of adding a 
Walmart gift card. Agree to the terms and conditions, 
re-enter your Walmart password, and then set up a PIN for 
Walmart Pay. After adding a PIN, you’re prompted to use 
Touch ID with Walmart Pay, which makes things a bit 
smoother.

Using Walmart Pay -- Unlike Apple Pay or Apple’s 
Wallet app, Walmart Pay doesn’t notify you when you enter 
a Walmart store, so you’ll have to open the app manually. 

https://webkit.org/blog/6589/next-steps-for-legacy-plug-ins/
https://webkit.org/blog/6589/next-steps-for-legacy-plug-ins/
http://hoyois.github.io/safariextensions/clicktoplugin/
http://hoyois.github.io/safariextensions/clicktoplugin/
https://groups.google.com/a/chromium.org/forum/#!searchin/chromium-dev/HTML5$20by$20default/chromium-dev/0wWoRRhTA_E/__E3jf40OAAJ
https://groups.google.com/a/chromium.org/forum/#!searchin/chromium-dev/HTML5$20by$20default/chromium-dev/0wWoRRhTA_E/__E3jf40OAAJ
https://blogs.windows.com/msedgedev/2016/02/03/2016-platform-priorities/
https://blogs.windows.com/msedgedev/2016/02/03/2016-platform-priorities/
http://tidbits.com/article/16509
http://tidbits.com/article/16509
https://itunes.apple.com/us/app/walmart-app-shopping-savings/id338137227?mt=8&at=10l5PW
https://itunes.apple.com/us/app/walmart-app-shopping-savings/id338137227?mt=8&at=10l5PW
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The app is location sensitive, though, so it will recognize the store, and at 
the top of the Shop tab, offer options for Walmart Pay, price checking, 
store search, and the weekly ad.

When you’re ready to check out, open the Walmart app and tap 

Walmart Pay. If your store is like mine, you’ll have more than enough time to do this while standing in line.
The actual Walmart Pay interface is a simple viewfinder. When you get to the register, the point-of-sale terminal displays a QR code. Center the 

QR code in the app’s viewfinder to link the two together and process your payment.
In theory, you can do this as soon as the clerk starts scanning your stuff. However, the QR code disappeared for a minute, and I had to press some 

buttons to get it back. Once I scanned the code, 
the process was pretty much seamless, if not 
quick. The transaction itself probably took at 
least as long as using a chip-based credit card, but 
it was a hands-off process.

Unlike Apple Pay, which seems to confuse 
every clerk I try it on, my Walmart Pay 
experience was relatively uneventful, though the 
cashier was baffled that a receipt didn’t print out. 
Instead, it’s sent to the Walmart app. Oddly, 
while you don’t receive a notification upon 
entering a store, you do receive one for your 
receipt.

Of course, like any of the mobile payment 
systems on the market, there are snags. Frequent 
TidBITS contributor Julio Ojeda-Zapata 
reported several problems in his tests, including 
failed transactions, delayed transactions, and 
repeat charges for the same item.

Unfortunately, the problem with Walmart 
Pay is much the same as Apple Pay: it’s more 
trouble than just using cash or a card for not 
much benefit. Factor in the potential 
embarrassment of the system not working, and 
you’re left with something that isn’t much more 
than a novelty.

However, if you shop at Walmart regularly, it’s 
probably a good idea to set up Walmart Pay, just in case you leave your wallet in the car.

http://www.twincities.com/2016/07/18/walmart-pay-is-here-but-you-may-experience-hiccups/
http://www.twincities.com/2016/07/18/walmart-pay-is-here-but-you-may-experience-hiccups/
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Can’t wait for the next newsletter to see what the guys and gals at Joy of Tech are up to? Then simply go on over to their 
website and see past and current cartoons and other things

http://www.joyoftech.com/joyoftech/
http://www.joyoftech.com/joyoftech/
http://www.joyoftech.com/joyoftech/
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Copy and Paste
by Josh Centers and Adam C. Engst  

Copy and paste may be the most important computing technology of the past 30 years. That may sound odd, but just think how much you rely 
on it. Most of us use the Copy and Paste commands multiple times every day, probably hundreds of times per week, without even realizing it.

If we didn’t have copy and paste, vast amounts of work would have to be done from scratch, rather than starting from previous bits of text, 
graphics, or entire documents that just need minor modifications. It would also be far harder to share links to Web pages. Sure, there are share 
buttons now, but would Twitter and Facebook have gotten off the ground if everyone had to link to cat videos by hand?

Surprising as this may be, some people still don’t understand the basics. And many others are missing out on advanced techniques with copy and 
paste, not to mention related ways of moving data between documents and apps.

Cut, Copy, and Paste Basics -- To understand what the Cut, Copy, and Paste 
commands do, you first must understand the concept of the clipboard, a virtual 
container that holds whatever data you copy or cut. Although the clipboard is 
generally invisible to the user, you can view its contents in the Finder — just 
choose Edit > Show Clipboard. A small window appears, displaying whatever text 
or image is currently on the clipboard.

Before you can use Copy or Cut, you must first select some data. That might be text ranging from a character to an entire book, an image or a 
portion of an image, a file in the Finder, a column of data in a spreadsheet, or a chunk of an audio recording. How you select varies with the 
situation and the data, but it usually involves clicking once, or clicking and dragging over an area. (Don’t forget the Command-A shortcut for Select 
All!) Once you have something selected, you can copy or cut it.

When you copy selected data, OS X duplicates it on the clipboard for later pasting. You might copy a street address to paste into a mapping app, 
copy a photo from Safari to share with a friend, or copy a file in order to move it to another folder.

Closely related to Copy is Cut, which combines the copy action with a delete action. When you cut selected data, it disappears from its original 
location and moves onto the clipboard. Cut is thus handy for rearranging things. For instance, if you’re writing a report, and you decide that you 
want to move a paragraph higher up, you can select that paragraph, cut it, and paste it in the new place.

How do you cut, copy, and paste? Once you select the content you wish to cut or copy, choose Edit > Cut or Edit > Copy. To paste the 
clipboard’s contents, make sure the destination document or folder is active, and then choose Edit > Paste.

But navigating to the menu bar every time you wish to cut, copy, or paste is mind-numbing. Every Mac user should memorize these commands’ 
keyboard shortcuts — invoking them should be as second-nature as typing:

• Cut: Command-X
• Copy: Command-C
• Paste: Command-V
Paste with Style, or Style with Paste -- Copying and pasting of text is simple, but it can get tricky when font styles are involved. You won’t have 

any problems when copying from or pasting into a plain-text editor like BBEdit. But let’s say you copy some text from a Web page and paste it into 
Apple Mail — it will transfer the typeface, text color, and even background color! All this style info can be useful in some cases, but most of the time, 
you probably just want the text to take on the look of the text around it, or to use the app’s default style.

In most apps, the command to paste text without any additional formatting is Edit > Paste and Match Style (Command-Option-Shift-V). Some 
apps might call it Paste Text Only or Paste Without Formatting.

Unfortunately, not all apps have such a command, even when it might be useful. To work around that limitation, turn to utility software, which 
you may already own. Macro utilities like Keyboard Maestro, launchers like LaunchBar, and clipboard utilities like Copy’em Paste can all remove 
formatting from text when pasting. For more details on these and other clipboard-related tricks, see Joe Kissell’s “Take Control of Automating 
Your Mac.”

Some apps (like Pages, TextEdit, and Messages) let you do the opposite, and copy and paste not the actual characters but instead the style of the 
source text. This capability is less common, and the location of the necessary commands varies widely.

In Pages, for instance, the Format menu contains Copy Style and Paste Style commands. In TextEdit, they’re in Format > Fonts. And in 
Messages, they’re in the Edit menu. Happily, the keyboard shortcuts remain the same, at least in Apple’s apps: Command-Option-C for Copy Style 
and Command-Option-V for Paste Style.

OS X Hidden Treasures

https://www.keyboardmaestro.com/
https://www.keyboardmaestro.com/
https://www.obdev.at/products/launchbar/
https://www.obdev.at/products/launchbar/
http://www.apprywhere.com/copy-em-paste.html
http://www.apprywhere.com/copy-em-paste.html
http://tid.bl.it/tco-automating-your-mac-tidbits
http://tid.bl.it/tco-automating-your-mac-tidbits
http://tid.bl.it/tco-automating-your-mac-tidbits
http://tid.bl.it/tco-automating-your-mac-tidbits
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OS X’s Little-Known Secondary Clipboard -- Whenever you copy or cut something, the new data overwrites whatever is on the clipboard. 

That can be annoying at times, forcing you to shuttle back and forth to move discrete chunks of data between apps. We don’t want to get 
sidetracked away from our focus on built-in capabilities of OS X here, but know that if you want access to your clipboard history, all the utilities 
mentioned just above provide those feature as well. You won’t go wrong with any of them, and if you want to work with multiple named 
clipboards, Keyboard Maestro and Copy’em Paste can help.

However, back in OS X, there is a secondary clipboard that’s accessible only via keyboard shortcuts: Control-K performs a kill, while Control-Y 
does a yank.

“Kill” and “Yank” are odd terms, but they come from the venerable command-line Emacs text editor. In practice, Kill and Yank are largely 
equivalent to the Cut and Paste commands, but with a few differences. Most notably, they have their own clipboard, which is known as a “kill ring” 
in Emacs, so cutting something with Control-K doesn’t replace whatever is on the main system clipboard. This special keyboard is specific to each 
app, so it can’t be used to move text between apps, but is helpful for rearranging text within an app.

There are other notable differences. Unlike Command-X, if you press Control-K when no text is selected, it affects everything from the insertion 
point to the end of the paragraph. If you perform multiple kills with no text selected, each bit of killed text is appended to the kill ring, such that a 
yank pastes all of them back at once. Finally, when you paste with Control-Y, all styles are automatically stripped from the pasted text.

Kill and Yank work in most OS X apps, but not all, and only seemingly in text-editing areas. Plus, some apps, particularly word processors and 
text editors, implement the Kill and Yank keyboard shortcuts in slightly different ways. For instance, in BBEdit, they seem to use the system 
clipboard, so you can kill text with Control-K and then paste with Command-V. And in Nisus Writer Pro, Yank can paste the text in the kill ring 
multiple times no matter how it got there, and it pastes with styles.

Copy and Paste in the Finder -- So far, we’ve focused on copying and pasting text, but many people don’t realize that you can also copy and 
paste files and folders in the Finder. Dragging is often easier, but there are situations where copy and paste can be more efficient.

To copy a file or folder, select it and choose Edit > Copy filename (Command-C). Make sure you’re selecting the icon and not text in its name. 
Using Shift-click or Command-click, you can select and then copy multiple items at once. Next, open the window showing your desired location 
and choose Edit > Paste (Command-V) to paste the items in that spot.

While you can’t use the Cut command on files or folders to move them, the Finder enhances the Paste command to enable you to move items 
instead of copying them. First, copy one or more items normally and, once you’ve navigated to the destination, press and hold the Option key, and 
then choose Edit > Move Item Here (it replaces Paste). The keyboard shortcut for Move Item Here is, unsurprisingly, Command-Option-V.

Remember, if you make a mistake and paste in the wrong place, regardless of whether you’re copying or moving the items, you can always press 
Command-Z to undo the action.

One final tweaky Finder tip. Sometimes you need to tell someone where to find a file or folder that’s nested deeply within the directory structure, 
such as this folder:

/Library/Application Support/Apple/Automator/Workflows 
Rather than type all that, you can copy the item’s pathname. With a file or folder selected, press and 

hold the Option key and choose Edit > Copy filename as Pathname (Command-Option-C). This 
copies, as text, the full pathname to the file or folder.

If you’re copying a pathname to paste it into the Terminal app as part of a command line invocation, 
there’s an even better way to do so: just drag the item into the Terminal window. This approach has the 
added benefit of reformatting the pathname as necessary.

Copying from Safari -- Although we’ve focused primarily on uses of copy and paste that work 
anywhere, many apps use the commands in particular ways as well. In particular, Web browsers make it 
possible to copy a variety of things. The details vary slightly between browsers, but in Safari, there are a 
few different things you can copy from a Web page:

• Text
• Destination URLs from hyperlinks
• Images
• Image URLs
Copying text works just as in any other app. However, for the other types of data, you need to 

Control-click (or right-click, or however you usually bring up a contextual menu) the link or image. 
Depending on what you’ve clicked, you can copy a URL or the entire image. (If you remember “The 
Power of Preview: Pulling Files into Preview” (25 February 2016), you can open a copied image in 
Preview by choosing File > New from Clipboard.)

Text Clippings and Drag-and-Drop -- This tip doesn’t use the clipboard precisely, but it offers 
similar functionality. After selecting text in almost any OS X application, you can drag it to your 
Desktop to create a “text clipping” — a special sort of file that contains the selected text. Text clippings 

https://www.gnu.org/software/emacs/
https://www.gnu.org/software/emacs/
https://www.gnu.org/software/emacs/manual/html_node/emacs/Kill-Ring.html
https://www.gnu.org/software/emacs/manual/html_node/emacs/Kill-Ring.html
http://tidbits.com/article/16284
http://tidbits.com/article/16284
http://tidbits.com/article/16284
http://tidbits.com/article/16284
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aren’t standard text files, and 
double-clicking them opens them 
directly within an unusual window in 
the Finder. You can’t edit a text 
clipping, but amusingly, you can select 
text in one clipping and drag it to the 
Desktop to create another clipping.

Creating a text clipping is like 
copying the text; to “paste” the text in a clipping, drag its icon from the Finder into an app’s window. In a sense, text clippings solve the problem of 
OS X having only a single clipboard, since you could make a number of text clippings, and then drag them in all at once. (You can select multiple 
clippings and drag them into a document simultaneously.)

Text clippings can contain either plain text or “rich text” in RTF format. Plain text clippings take on the formatting of the surrounding text when 
dragged into a document, whereas rich text clippings retain their styles.

Some text editors and word processors — like BBEdit and Nisus Writer Pro, though not TextEdit and Pages — can open text clippings as 
documents, but said documents are new, and there’s no way to save changes back to a clipping. You cannot edit a text clipping in any way.

But wait! If you just want to move some text from one document to another, or even from one app to another, you don’t have to create an 
intermediary text clipping. Instead, just select the text and drag from one window to the other. This drag-and-drop trick works with graphics too.

What if the document into which you want to drop isn’t visible, or even open? Try this excruciatingly neat set of steps:
• In an app like Safari, select some text and start dragging.
• Drag the text to the Dock icon of an app that accepts text drops, like TextEdit or Pages.
• Continue the drag (don’t let up 

on the mouse button) and pause 
while the Dock icon is 
highlighted; everything on the 
screen will disappear, except for 
smaller windows representing 
that app’s open windows and 
thumbnails at the bottom of the 
screen representing recent files.

• Continue the drag to one of the 
open documents or thumbnails, 
and once your pointer is over it, 
pause again. The screen returns to 
normal, and the document you 
paused over opens.

• Still continuing the drag, move 
the pointer to the top or bottom 
of the document to scroll within 
the document until you’ve 
located the spot where you want the dragged text to appear. (With your other hand, you can even use navigation keys like Page Up and Page 
Down at this point!)

• Once you’ve positioned the insertion point as desired, let up on the mouse button to “paste” the text in that location.
You can start a drag and then use the Command-Tab application switcher to switch between apps as well, but that approach doesn’t provide any 

way to select recently used documents that aren’t open, as dragging to the Dock does.
It’s Pasteboards All the Way Down -- Text clippings and drag-and-drop don’t use the clipboard, but we mention them because they rely on the 

same underlying technology, which Apple calls “pasteboards.” In OS X, pasteboards are a standardized mechanism for exchanging data within an 
app or between apps. The clipboard is just one standard public pasteboard that all applications share; drag-and-drop operations use a different public 
clipboard, and the Kill and Yank commands presumably use yet another. Apple’s developer documentation about pasteboards actually makes for 
some interesting reading.

While pasteboards are conceptually simple, implementing them well can be quite complex. For instance, different apps can handle various types 
of data, and it’s up to each app to put all the appropriate types of data on the shared pasteboard so as many other apps as possible can access it. That 
doesn’t always happen, so, for instance, you can drag a picture from Photos to Apple Mail, but you can’t drag one to Mailplane because Photos isn’t 
giving Mailplane a representation of the picture that Mailplane understands.

https://developer.apple.com/library/mac/documentation/Cocoa/Conceptual/PasteboardGuide106/Articles/pbConcepts.html
https://developer.apple.com/library/mac/documentation/Cocoa/Conceptual/PasteboardGuide106/Articles/pbConcepts.html
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iPhone & iPad 
Comparing iPad Pro Technologies and Intangibles

by Julio Ojeda-Zapata 
The iPad Pro, released in a 12.9-inch model in September 2015 and a 9.7-inch flavor in March 2016, has been touted as a breed apart.
Though the iPad Pros resemble previous iPad models, they’re tricked out 

with a magnetic Smart Connector for use with a Smart Keyboard cover, and 
they also work with the new Apple Pencil stylus.

Apple’s emphasis with the iPad Pro is on productivity, an angle I’ve 
embraced with gusto. Though I have long been fond of writing and doing 
other work on an iPad, the iPad Pro has taken over for an Apple laptop as my 
preferred workhorse while on the go.

The question is, which iPad Pro? There’s the rub.
I’ve made extensive use of both models in recent months and love them 

both for different reasons. While they seem nearly identical on the surface – 
apart from size and weight, of course – they are quite distinct in some ways.

The newer 9.7-inch model boasts certain advanced features that its older 
12.9-inch sibling lacks, while the big iPad Pro outpaces the smaller one in several significant ways.

Advantages of the 9.7-inch iPad Pro -- The smaller iPad Pro, because it’s newer, incorporates cutting-edge technology that presumably wasn’t 
ready when Apple released the bigger iPad Pro.

• Display: Apple advertises the small iPad Pro as having the “brightest and least reflective” screen anywhere, with colors that “are more vivid, true 
to life and engaging.” It adds that the smaller tablet “uses the same color space as the digital cinema industry,” with a wider color gamut that gives 
the device up to 25 percent greater color saturation than previous models.

Fair enough, but I’m not sure I would have noticed this without being prompted. And, after much squinting at the two displays, I can’t 
honestly think a user of the bigger iPad would feel cheated.

In another respect, the display on the smaller tablet is starkly different. It offers a “True Tone” screen with built-in sensors that alter its 
appearance based on ambient lighting conditions. This feature adjusts the display color and 
intensity to match lighting around it.

I found True Tone jarring at first but grew to like it. Peering at the two iPads in my 
customarily dim home office on a late afternoon, for instance, the screen on the larger iPad Pro 
had a decidedly bluish tint while the smaller iPad appeared warmer and more inviting.

True Tone is different and separate from the Night Shift feature that aims to make a screen 
more comfortable to read in low-light conditions. True Tone and Night Shift often seem to 
behave similarly, although Night Shift is based on timers and not physical sensors. I solved the 
confusion by keeping Night Shift switched off on the 9.7-inch iPad.

• Cellular access: Integrated support for cellular data connections in some iPad models sets them 
apart from Apple laptops, none of which can yet boast such connectivity. However, the two 
iPad Pro models have different cellular capabilities.

The 9.7-inch model supports a cellular data feature called LTE Advanced that is available 
from some carriers, including AT&T. LTE Advanced can boost Internet performance 

Should you want to connect clipboard data with Unix apps, check out the pbcopy and pbpaste commands. Explaining how to use them is 
beyond the scope of this article, but you can start at their man pages.

Here’s a final bit of geeky trivia. Since you can copy data, quit the source app, launch the destination app, and then paste, it’s clear that copy and 
paste has to rely on yet another background app to work its magic. That pasteboard server process is called pbs, so if you see it in Activity Monitor, 
you’ll know that it’s powering your clipboard and drag-and-drop, not prepping for the next pledge drive.

Needless to say, you don’t need to know anything about pasteboards, but it’s a testament to Apple’s OS X engineers that moving data between 
apps with copy and paste, text clippings, and drag-and-drop is so easy. Now let’s show our appreciation by putting these subtle features to use! And, 
of course, if you have any other clipboard- or pasteboard-related tips, let us know.

http://www.apple.com/ipad-pro/
http://www.apple.com/ipad-pro/
http://www.apple.com/smart-keyboard/
http://www.apple.com/smart-keyboard/
http://www.apple.com/apple-pencil/
http://www.apple.com/apple-pencil/
http://www.apple.com/ipad-pro/
http://www.apple.com/ipad-pro/
https://en.wikipedia.org/wiki/LTE_Advanced
https://en.wikipedia.org/wiki/LTE_Advanced
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dramatically. In my speed tests, cellular downloads tended to be as much as 50 percent faster on the smaller iPad Pro model than on the large 
one.

Apple also eliminated the need for an add-in Apple SIM in the 9.7-inch iPad Pro, though the tablet still has a nano-SIM tray if your carrier 
requires a physical SIM. Instead, it has a new feature called embedded Apple SIM that internalizes the SIM card’s features.

Regardless of whether the Apple SIM is embedded or not, it exists to make life easier for those who need cellular service in foreign lands. 
Obtaining a physical SIM for such service has been a longtime ritual for overseas travelers, but Apple SIM users can sign up for cellular service 
right on their tablets as they move from place to place. So the difference between the two Apple SIM types seems a minor one, allowing most 
users of the smaller iPad Pro to ignore the nano-SIM tray.

• Camera and photos: People like taking photos with their iPads, no matter how awkward it may look, and those who do should know that the 
cameras on the iPad Pro models differ in significant respects.

The larger iPad has an 8-megapixel rear-facing camera with an f/2.4 aperture that shoots 1080p video. Its front-facing camera has a 
1.2-megapixel resolution with an f/2.2 aperture and takes 720p video. Neither camera has a flash, which is a distinct disadvantage.

The smaller iPad has a 12-megapixel rear-facing camera with an f/2.2 aperture that shoots 4K video. It adds a True Tone flash, found on 
certain iPhone models, whose white and amber LEDs can produce more than 1000 different color temperatures to achieve a better white 
balance.

Its front-facing camera has a 1.2-megapixel resolution with an f/2.2 aperture and shoots 720p video. It adds a Retina Flash feature that, as on 
the iPhone 6s and 6s Plus, turns the screen into a flash and makes for an unusual selfie experience as the screen momentarily turns bright white 
for subtle illumination.

The smaller iPad can take Live Photos, a capability absent from the larger model.
• Hey Siri: Only the smaller iPad boasts the always-on feature that puts Apple’s intelligent assistant at your beck and call.

Advantages of the 12.9-inch iPad Pro -- The larger of the iPad Pro models, though older, is superior to the small one in several tangible ways.
• Lightning port: The Lightning port on the bigger iPad incorporates the zippy USB 3.0, while the one on the smaller iPad offers only the slower 

USB 2.0.
This difference likely means little to most people, but it has serious ramifications for certain types of users, such as photographers.
“For photographers who want to transfer photos for review or editing from a camera to the iPad, this is almost crippling,” my TidBITS colleague 
Jeff Carlson recently observed on his personal blog. Jeff found that transferring 1.5 GB of images took 30 seconds via USB 3 and 2 minutes 
20 seconds via USB 2.

• Performance: Though roughly similar to the 9.7-inch model in terms of internal specs, the 12.9-inch model offers slightly superior 
performance.
   It has 4 GB of RAM, compared to the smaller tablet’s 2 GB. And while both tablets have an A9X chip, both raw processing and graphics are 
zippier on the larger iPad.
   Honestly, though, I seldom noticed the difference while using both iPads.

• Faster charging: As I noted in “iPad Pro Charges Faster with MacBook Adapter and New Cable” (27 April 2016), charge times on the large 
iPad can be reduced by about half by swapping out its standard charger for the 29-watt USB-C Power Adapter that comes with the 12-inch 
MacBook and pairing it with one of Apple’s new USB-C to Lightning cables.
   The fast-charging capability in the 12.9-inch iPad makes this trick possible; alas, the 9.7-inch model lacks the fast-charging feature.

The Intangibles -- In many ways, purchasing an iPad is a highly personal decision. One potential buyer might find the larger iPad Pro too big and 
heavy, while it might be just right for another. For some, the version of the Smart Keyboard for the 9.7-inch iPad might feel intolerably cramped, but 
not for others.

I’ll focus here on my experiences while broadening my discussion to include others who might be considering a purchase.
• Smart Keyboard: The dimensions of the Smart Keyboard for the bigger iPad are deliciously ample. I expected the smaller Smart Keyboard, like 

other keyboards and keyboard cases designed for 9.7-inch iPads models, to feel scrunched to me.
   However, my concerns were laid to rest when I started using it. I did serious work on the thing with little discomfort. Your mileage may vary; I 
recommend trying both in a store.

• Screen considerations: The larger iPad’s generous screen size can be critically important for some people. On the larger iPad, each side of the 
screen in Split View has as much display area as the smaller iPad’s display, which is great for productivity. Split View on the smaller iPad is less 
useful given the narrowness of each panel.
   This, of course, assumes app developers have updated their offerings to support Split View. Some have not. As I’ve previously noted, Google’s 
refusal to implement this basic feature in some of its iOS apps (such as Google Docs, which I’m using to type these words) is one of the great 
mysteries of the universe.
   That issue impacts both iPad Pro models, but there’s a related one that involves only the big iPad. In many cases, developers have been slow 
about updating apps to take advantage of the 12.9-inch screen. I’m looking at you, Facebook. Google has been maddeningly inconsistent in this 

https://www.apple.com/ipad/apple-sim/
https://www.apple.com/ipad/apple-sim/
https://jeffcarlson.com/2016/03/22/the-9-7-inch-ipad-pro-and-the-missing-usb-3-speed/
https://jeffcarlson.com/2016/03/22/the-9-7-inch-ipad-pro-and-the-missing-usb-3-speed/
https://tidbits.com/article/16456
https://tidbits.com/article/16456
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regard, updating some apps (such as Inbox) but not others (like Gmail).

• Size and weight: At just under 1 pound (454 g), the 9.7-inch iPad Pro feels much more portable than the 12.9-inch model, which weighs 1.6 
pounds (726 g).

  The larger iPad Pro initially struck me as ridiculously large. It seems like a cafeteria tray – and I have even used it to transport meals from the 
kitchen to the front porch a few times.

For those with similar concerns but lusting after that big screen, I’d suggest a couple of strategies. Go for the Smart Cover (and, optionally, the 
matching Silicone Case) instead of the bulkier Smart Keyboard. With the cover and the case, the 12.9-inch iPad Pro struck me as a thin and light 
laptop.

Then, when you need it, add an external Bluetooth keyboard. There are many such options, some of which I covered in “Three Alternatives to 
the iPad Pro’s Smart Keyboard” (8 February 2016).

One of the accessories in that article, the Zagg Messenger 
Universal, remains my favorite as a large and comfy keyboard 
with an integrated fold-out stand that is more than stable 
enough to hold the larger iPad (in either portrait or landscape 
orientation). I get a ton of work done on it at home. The Zagg 
Messenger Universal is thin enough that I have been known to 
take it on the road with the iPad despite the added weight and 
bulk, though it is mostly for home use.

Keyboard cases for the larger iPad Pro don’t make a lot of 
sense to me — why bulk up the already large device? They 
make more sense for the smaller iPad. 

Again, numerous options are available. I prefer Zagg’s 
Rugged Book, which bulks up the tablet a bit, but seems 
indestructible (I throw it into my bike pannier every morning 
for my commute without a second thought) and has four 
positioning/viewing modes. The tablet detaches, as well, when I 
just want a touch experience. When I need to type, the Rugged 
Book’s keyboard feels fantastic, though, of course, a bit 
cramped.

Be sure to buy the version for the iPad Pro. The similar iPad Air 2 model will fit the iPad Pro form factor, but does not have its magnets correctly 
positioned to activate the tablet’s sleep mode when the lid is closed.

Conclusion -- Most people won’t have both iPad Pro models available to compare. I’m lucky to have both versions on loan from Apple, which 
has been a revealing experience.

I’ve found a role for each tablet. The larger iPad Pro is mostly for home use – on my front-porch workstation, for instance, when I want to get 
some serious work done while enjoying a bit of fresh air.

The smaller iPad Pro is my mobile model. It goes with me everywhere. I tuck it into a small messenger bag if I’m walking, chuck it into my 
pannier when biking, and have it with me in my car at all times.

If I had to choose? I’d get the 9.7-inch model because it does everything the bigger tablet can, though sometimes in a more cramped manner, and 
it has some cool new features.

You’ll make your own decision based on your particular set of needs and circumstances, but you can’t lose. Both models are great, though with 
key differences that you should mull over carefully before making your purchase.

On the iPhone, Virtual Reality Is Unofficially Real
by Julio Ojeda-Zapata

The common conception of “virtual reality” is a simple one: don futuristic goggles and journey to simulated yet hyperrealistic worlds. But while 
such virtual reality has been a staple of sci-fi books and films, it has not been easy to pull off in actual reality.

Serious attempts have been made since at least the 1990s, when VR stations popped up in movie theaters and video game arcades. Those efforts 
went nowhere, as a Kill Screen article details.

Now, though, a VR revolution appears to be underway for real – with the iPhone and other smartphones at the heart of the movement.
Imagine you are using your iPhone to watch a video of a helicopter flight over Manhattan. Instead of gripping your iPhone, however, you’ve 

placed it into a goggles-style mount that looks like a jumbo-sized View-Master.
The video itself is unusual, with two slightly different scenes, one for each eye. With the iPhone in its mount placed in front of your eyes, though, 
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the two images blend into a single stereoscopic view that mimics the physical world. This is 360-degree video. You can look right and left, up or 
down, or all around. As you turn your head, your view shifts just as if you were there – and you might just feel vertigo as you float past 1 World 
Trade Center.

That, in a nutshell, is virtual reality – and it has lately been all the rage in the computer and smartphone universes. It’s a tech trend that appears to 
be taking hold, unlike fizzled technology fads like 3D TVs.

The last two years have seen a steady succession of VR hardware products, ranging from souped-up VR goggles for use with computers and game 
consoles to simpler, cheaper gadgetry meant to work with smartphones.

VR software and content has exploded too, with numerous hyperrealistic games for PC- and console-connected VR gear and an abundance of 
VR apps for iOS and Android. Video portals such as YouTube and Facebook have lately added a wealth of VR content, much of it viewable with 
VR goggles.

It’s a tricky time for Apple as competitors like Google, Facebook and Samsung push aggressively into VR. Apple has stayed silent on the subject, 
apart from one statement by CEO Tim Cook, who responded to a recent analyst question about VR by saying “No, I don’t think it’s a niche. It’s 
really cool and has some interesting applications.” Behind the scenes, the company is surely investing R&D resources to keep abreast of its 
technology rivals. If and when it will jump in is anybody’s guess.

Apple a VR Trendsetter? -- Despite this outward indifference, Apple is already, in a sense, a VR pioneer.
Longtime Apple aficionados may recall a QuickTime format called QuickTime VR that provided a rudimentary sort of virtual reality using still 

images (see “QuickTime VR is Actually Real,” 17 July 1995).
QuickTime VR content creators used 

specialized camera setups to capture images 
in all directions and then stitch these 
photographs together on a Mac to create 
spherical or cylindrical environments.

The result, from the user’s perspective, 
was a virtual tour of a building’s interior or 
an outdoor landscape that you could view 
on a computer screen in multiple directions — left and right and, in some cases, up and down – using mouse swipes for navigation.

Apple long ago stopped talking about QuickTime VR, which is now seemingly defunct, but its approach lives on in other photo tools that allow 
for the creation of similar virtual tours. Google makes it possible for amateurs and pros alike to wield the Street View app for shooting “photo 
spheres” that can be uploaded for public 360-degree viewing on Google Maps, for instance.

Notably, the photo-sphere technology was used not long ago to capture crowds of grieving Prince fans at a couple of Twin Cities locations 
after the singer’s demise.

Facebook recently unveiled the similar 360 Photos. Users can upload 
photographic panoramas, such as those snapped with the iPhone’s Camera 
app or Google’s Street View app, to be transformed into 360-degree 
environments.

VR for iPhone Users -- For Apple users wanting to experiment with VR, 
the iPhone makes it easy, though this approach is far from cutting-edge as VR 

tech goes.
  First, you need a face mount for your iPhone. In 2014, Google 
created “Cardboard,” a specification for phone holders made of 
inexpensive materials like cardboard, foam, and plastic.
  Dozens of Cardboard variations are now available for purchase. They 
vary widely in appearance, but none cost a fortune, and all serve exactly 
the same role in transforming a smartphone into a virtual reality 
viewer.
  I’ve experimented with a handful of Cardboard variants, including 
the entry-level $15 Google Cardboard, a fold-out cardboard 
variation with bits of Velcro to hold everything in place, and the Powis 
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ViewR, a $30 apparatus with better lenses along with foam cushioning for the 
phone.

Non-Cardboard variations are available, too. Speck has released Pocket-VR 
goggles that are meant to be used with an iPhone 6 or iPhone 6s, but require a user to 
have a matching Speck case.

Plus, a company called Merge makes Merge VR out of foam with a more flexible 
design made to accommodate virtually any smartphone model from the past two 
years.

Firing up VR Apps -- Once you’ve purchased your VR mount and slipped your 
iPhone into it, it’s time to experiment with VR apps. These are legion and – fair 
warning – there’s a lot of garbage out there.

Many VR-based games are crude constructs that seemingly exist just to promote 
non-VR iOS games. Even apps that are good-faith attempts to provide VR 
experiences are often abysmally designed with weak content and coarse image quality.

I’ve combed through the App Store and turned up a few VR gems. They include:
• Cardboard: Google’s VR-demo app is a good place to start, with a 

set of attractive computer-animated sequences that let you interact 
with seagulls and wolves, plant seeds that grow into flowers, and 
gape at a breaching whale and a pulsating aurora.

• Street View: There’s a VR component to this popular Google 

service, which lets you view and navigate urban streets around the 
world. Fire up the Street View app on an iPhone and pull up an 
address to see that location in all of its photographic glory. Then, 
tap the goggles icon on the lower right, and put the phone in your 
Cardboard. Presto: you see that location in virtual reality.

• Google Spotlight Stories: Google has commissioned a series of 
shorts, mainly computer-animated, that show the power of VR 
storytelling. The film “Pearl,” about a young girl living in a car with 
her dad, will touch you. “Help,” a blend of CGI and live action, 
starts with an alien crashing to the Earth and starting to grow…

• Within: Visual journalism and other varieties of visual storytelling 
are the most compelling VR use at the moment, and a number of 
apps serve as showcases for such content. One such app, Within 
(formerly called Vrse), provides a library of VR stories from a variety 
of sources, like the New York Times. My favorite video is “A 
History of Cuban Dance,” which make you feel like you are on the 
island.

• On a related note, see a recent Medium post by Chris Milk, 
founder of Within, who takes a deep dive into the subject of VR, 
how he believes it’s far more than a fad, and why he decided to 
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https://itunes.apple.com/us/app/within-vr-virtual-reality/id959327054?mt=8&at=10l5PW
https://itunes.apple.com/us/app/within-vr-virtual-reality/id959327054?mt=8&at=10l5PW
https://medium.com/%40chrismilk/futureofvr-8be30f0fca6a#.8nnprm187
https://medium.com/%40chrismilk/futureofvr-8be30f0fca6a#.8nnprm187
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change the company’s name.

• NYT VR: If Within whets your appetite for VR from the Gray Lady, 
this app provides more, including a tour of Pluto and a climb to the 
top of 1 World Trade Center (cue vertigo).

• Ryot Another VR-journalism smorgasbord, Ryot includes a separate 
visit to Cuba. Alas, I found that its video quality is sometimes subpar.

•Jaunt: Still more storytelling, Jaunt offers an assortment of VR videos 
focused on journalism as well as sports and music events. If you have 

fantasized about being on-stage with Paul McCartney as he belts out 
“Live and Let Die,” this is your chance. Again, video quality is iffy at 
times.

• Sisters: Most VR-based video games for smartphones are lousy, as I 

mentioned, but there are exceptions. Sisters is a sort of ghost story set in 
a sitting room with a creepy backstory and a malevolent presence. 
You’ll have to keep looking around – regretfully at times – as the story 
unfolds.
• Rhapsody VR: The Rhapsody music-streaming service has entered 
the VR world with the Rhapsody VR app that plays virtual-reality 

concert recordings. Most are from the South by Southwest music 
festival, and one is a Prince tribute recorded outside a Minneapolis music 
venue after the singer died.

VR Video Streaming -- Beyond the limited world of apps, there are 
thousands of VR videos that you can stream just like any other video, 
though with enhancements. As you watch a VR video, you can pan 
around with your mouse on a computer or with a finger on a smartphone 
screen to see in all directions. Similarly, when watching VR on a 
smartphone, you can swing the device around while held in your hands to 
change the vantage point within the 360-degree environment.

Streaming VR video shines, however, when viewed with VR goggles, 
such as the Cardboard variants. In this regard, it behaves no differently 
from Cardboard-compatible content in the aforementioned VR apps. In 
fact, a lot of the content found in those apps, like the “Pearl” animated short, also is available as streaming video.

There’s a ton of VR video available for streaming, though. A great deal of this is on YouTube, which is arguably the preeminent venue for VR 
streaming. Unfortunately, as with VR apps, there is a lot of VR crud. When watching 360-degree YouTube on your iPhone, be sure to do so with 

https://itunes.apple.com/us/app/nyt-vr-virtual-reality-stories/id1028562337?mt=8&at=10l5PW
https://itunes.apple.com/us/app/nyt-vr-virtual-reality-stories/id1028562337?mt=8&at=10l5PW
https://itunes.apple.com/us/app/ryot-vr/id1046058227?mt=8&at=10l5PW
https://itunes.apple.com/us/app/ryot-vr/id1046058227?mt=8&at=10l5PW
https://itunes.apple.com/us/app/jaunt-vr-cinematic-360-virtual/id1048352748?mt=8&at=10l5PW
https://itunes.apple.com/us/app/jaunt-vr-cinematic-360-virtual/id1048352748?mt=8&at=10l5PW
https://itunes.apple.com/us/app/sisters-virtual-reality-ghost/id957212695?mt=8&at=10l5PW
https://itunes.apple.com/us/app/sisters-virtual-reality-ghost/id957212695?mt=8&at=10l5PW
https://itunes.apple.com/us/app/rhapsody-vr/id1109158440?mt=8&at=10l5PW
https://itunes.apple.com/us/app/rhapsody-vr/id1109158440?mt=8&at=10l5PW
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the YouTube app, and not using YouTube’s site in Safari or Chrome.

A good place to start is Google’s own 360° Videos channel, with scads of VR sequences. These are of wildly variable quality, though.
So I created this playlist with a few of my favorites, including:
• A tour of Minnesota landscapes
• A clever music video
• A flight with Swiss jet fighters
• An encounter with wild elephants
• A trip into SyFy’s “The Expanse” sci-fi series
• A fight against a kaiju as a “Pacific Rim” jaeger pilot
• That Manhattan flyover I mentioned earlier
Facebook is another high-profile source of 360-degree videos, but strangely, the VR sequences on its site are currently incompatible with 

phone-powered goggles, and can be interacted with only by panning with your fingertip or swinging a phone around while in your hands to see in 
every direction. For now, only Facebook’s 360 Photos support goggles.

Creating VR Content -- Most Apple users are happy just to watch VR videos. But for those who want to plunge into VR content creation, the 
cost and complexity of such projects have dropped dramatically of late.

Until recently, if you wanted to make a VR video, you needed multiple GoPro cameras shooting in unison while fitted into a special mount. The 
footage from the GoPros then had to be stitched together on powerful computers using specialized software. Such a setup could cost tens of 
thousands of dollars.

While such pro gear is still required to create the highest quality video, options for frugal amateurs are beginning to emerge. One good example is 
the 360fly brand of consumer VR cameras, each of which consists of a little ball with an integrated panoramic 
lens for 360-degree shoots.

I’ve experimented with a $399.99 360fly HD model, which shoots mediocre video and provides primitive 
editing tools (including Mac and iOS apps). Still, it’s a total rush to shoot VR content with this camera, as I did 
during a St. Paul winter carnival parade and at a local blogging conference. 360fly provides all manner of 
mounts for attaching the camera securely to a tripod, ski helmet, bicycle handlebars, and even a surfboard.

The video does not measure up to professional VR video, such as the piece a friend of mine shot at the 
carnival parade using his multi-GoPro rig, but it hints at what is yet to come for casual VR-content makers. 
Already, a $499.99 4K version of the 360fly is out, and the manufacturer’s software is improving.

For those who aren’t satisfied with the simple video-editing apps offered, it is possible to pull off more 
sophisticated VR video editing in Final Cut Pro after just a bit of self-training – I got the hang of it after a day 
or two.

Entry-level VR cameras also can be used to shoot Google Photo Spheres and Facebook 
360 Photos. Ricoh’s $349 Theta S is a camera suitable for such Google and Facebook 
use, and the device includes Mac as well as Windows software. The 360fly camera should 
work properly for this as well, but I haven’t tested it yet (my 360fly HD review unit was 
on the fritz as I wrote this).

Apple at a VR Disadvantage? -- While a lot is going on with VR and Apple devices, 
those wanting Apple to be at the forefront of the wave have reason to fret.

While Apple remains mostly silent on the subject, competitors like Samsung are 
aggressively pushing into this market. Samsung has been giving away its Gear VR 
goggles to those who purchase compatible handsets such as the Galaxy S7 and Galaxy 

S7 Edge.
Samsung is about to 
release a $361 Gear 
360 cam, as well, and that 
device apparently works only 
with Windows PCs.
 Google, meanwhile, is 
positioning its Android 
platform for a VR future with 
Daydream, a just-announced 
set of software enhancements 
and hardware specifications for 

https://itunes.apple.com/us/app/youtube/id544007664?mt=8&at=10l5PW
https://itunes.apple.com/us/app/youtube/id544007664?mt=8&at=10l5PW
https://www.youtube.com/channel/UCzuqhhs6NWbgTzMuM09WKDQ
https://www.youtube.com/channel/UCzuqhhs6NWbgTzMuM09WKDQ
https://www.youtube.com/watch?v=HLPNC6ef928&index=1&list=PLOb-7szO4v-hljz51fkCbqeTgxDhwU0wX
https://www.youtube.com/watch?v=HLPNC6ef928&index=1&list=PLOb-7szO4v-hljz51fkCbqeTgxDhwU0wX
http://360fly.com/
http://360fly.com/
https://www.youtube.com/watch?time_continue=20&v=44PWvML4WaY
https://www.youtube.com/watch?time_continue=20&v=44PWvML4WaY
https://www.facebook.com/MNBlogCon/posts/1017634474963455
https://www.facebook.com/MNBlogCon/posts/1017634474963455
https://www.youtube.com/watch?v=R8o2hHPgtOg
https://www.youtube.com/watch?v=R8o2hHPgtOg
https://shop.360fly.com/catalogue/360fly4K_3/
https://shop.360fly.com/catalogue/360fly4K_3/
https://forums.360fly.com/t/editing-spherical-video-in-final-cut-pro/44
https://forums.360fly.com/t/editing-spherical-video-in-final-cut-pro/44
https://theta360.com/en/about/theta/s.html
https://theta360.com/en/about/theta/s.html
http://www.samsung.com/us/explore/galaxy-s7-features-and-specs/#promo
http://www.samsung.com/us/explore/galaxy-s7-features-and-specs/#promo
http://www.samsung.com/us/explore/galaxy-s7-features-and-specs/#promo
http://www.samsung.com/us/explore/galaxy-s7-features-and-specs/#promo
http://www.samsung.com/us/explore/gear-360/
http://www.samsung.com/us/explore/gear-360/
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a new generation of VR-friendly Android gizmos. Such devices will include 
phones, goggles, and handheld controllers, some of which Google plans to 
make itself.
   It is much the same in the desktop computer arena, with a new generation 
of souped-up VR goggles like the Oculus Rift and the HTC Vive that 
require physical tethering to powerful PCs to provide their VR experiences. 
Even the most powerful Macs are apparently not powerful enough.

   In March 2016, Oculus VR founder Palmer Luckey famously dissed 
the Mac. When asked if he’d consider making Oculus VR hardware 
compatible with the Mac, he responded, “That is up to Apple. If they ever 
release a good computer, we will do it.”

Microsoft and Sony have jumped into the VR arena, as well, each in 
their own way. Microsoft is perfecting a HoloLens headset that will 
combine VR with “augmented reality” (see “Microsoft’s New Hardware 
Challenges Apple’s,” 14 Oct 2015). Sony has taken a purer VR tack with 
a VR headset and related gear for use with the PlayStation 4 gaming 
console.

Your Move, Apple? -- All these high-profile developments in the VR 
space prompt the question: Where’s Apple?

Apple enters new markets carefully, and the company is not the sort to 
jump on bandwagons recklessly, even though it might be feeling pressure 
to do so.

Remember the cheap laptops known as “netbooks”? They were hot stuff 
at one time, and many an expert said Apple was foolish not to offer its own 
such laptop. Apple ignored that advice and, at a later date, released the iPad 
while publicly dismissing the netbook.

Apple is surely following VR developments closely, and probably even 
fashioning prototype hardware and software in its top-secret labs. As with MP3 players back in the day, the company is likely biding its time and 
permitting others to make the initial moves and mistakes before it shows its hand, which it eventually did with the iPod.

And who knows? VR may be just a fad and prove experts wrong yet again. But signs point to VR sticking around, and if so, Apple will have to 
enter the market at some point.

For now, though, there are plenty of independent Apple-friendly VR options to keep tech aficionados entertained.

ExtraBITS
Eddy Cue Discusses Apple’s TV Business -- In an interview with the Hollywood Reporter, Eddy Cue, Apple’s Senior Vice President of Internet 
Software and Services, opened up about Apple’s interest in the TV business. Cue said that the Apple TV is “a lot better than a cable box,” but when 
asked if Apple is planning a streaming service, he responded, “Whether we’re providing it or somebody else is, it really doesn’t matter to us.” 
However, Cue did say that he’s not a fan of so-called “skinny bundles” — smaller, low-cost programming packages — offered by services like 
SlingTV because he feels that viewers are more frustrated by a lack of features than the price. In particular, he criticized the idea of having to dig 
through channel guides and program recordings manually. Overall, it sounds like Apple has a vision for the future of TV but doesn’t know exactly 
how to get there yet.

http://www.shacknews.com/article/93547/oculus-palmer-luckey-will-consider-mac-support-if-apple-ever-releases-a-good-computer
http://www.shacknews.com/article/93547/oculus-palmer-luckey-will-consider-mac-support-if-apple-ever-releases-a-good-computer
http://youtu.be/ijyBMpm2bqQ?t=243/ijyBMpm2bqQ?t=243http
http://youtu.be/ijyBMpm2bqQ?t=243/ijyBMpm2bqQ?t=243http
http://tidbits.com/e/16007
http://tidbits.com/e/16007
http://tidbits.com/e/16007
http://tidbits.com/e/16007
https://www.playstation.com/en-us/explore/playstation-vr/
https://www.playstation.com/en-us/explore/playstation-vr/
http://www.hollywoodreporter.com/news/eddy-cue-apples-tv-plans-910093
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Bob “Dr. Mac” LeVitus’ Tips
                            Efficient

This week's newsletter is brought to you by the word efficient, which the OS X (soon to be macOS) 
Dictionary defines as achieving maximum productivity with minimum wasted effort or expense.

This piece of wit and wisdom is all about efficiency and once again, is adapted from my upcoming 
ebook, Working Smarter for Mac Users (coming this Fall).

Author Kevin Kruse talks about there being just 1,440 minutes in a day, and describes the myriad techniques 
successful people use to avoid wasting them. I learned a lot from his book, 15 Secrets Successful People 
Know About Time Management: The Productivity Habits of 7 Billionaires, 13 Olympic 
Athletes, 29 Straight-A Students, and 239 Entrepreneurs, but the biggest take-away, at least for me, 
was that successful people plan their day in advance and don’t waste precious time trying to figure out what to do 
next.

1,440: It's a Reminder!
I like Kruse's 1,440-minute concept so much I’ve got little “1,440” notes in places I’ll see them every day, to 

remind me that I probably have work to complete... I have them all over the house, including (but not limited 
to): my office (top left and right), my den (lower left), and even the bathroom (lower right).

To become truly efficient and effective, I believe you have to plan your day and then stick to the plan 
(as best you can). Of all the concepts you’ll discover in my ebook (Working Smarter for Mac Users), this 
is perhaps the most important.

You've got to have a plan every day. You have to determine what's important, and then map out the 
time to do it properly.

If you’re thinking that sounds like too much trouble, or too much work, you’re dead wrong. When 
you have a plan in front of you, you can't help but spend more of your precious time working and less 
time trying to figure out what you should do next.   

So, Make a New Plan, Stan…
So here’s my advice, especially for those prone to procrastination: Make a 
plan tonight detailing how you’ll spend every half-hour of your workday 
tomorrow. My productivity skyrocketed when I began writing down what needed to be done tomorrow and 
allocating time blocks to each task. Now, when I walk in the office in the morning, I know exactly what to do first and 
for how long. 
  I use a two-prong digital/analog approach to my planning process. The 
backbone is Fantastical, the Mac/iOS calendar app I use instead of the 
macOS/iOS Calendar app. That’s where all my events, meetings, 
appointments, travel, deadlines, and anything else that’s time or date-based 
are stored. That’s the digital part and it’s awesome.
  And, while I could use Fantastical to plan my workday (and you could 
use it, or Calendar if you prefer), that would be too much work for me, 
and it makes my calendar too crowded to be much use. Plus, I have a 
(small) collection of (mostly cheap) fountain pens, and I like to use ‘em.
So I use a fountain pen, and write my plan for tomorrow longhand each 
night. I’m kind of old-school that way, but that’s what works for me. For 
those who prefer an all-digital, all-analog, or some other approach, that’s 
perfectly OK. The thing that’s important is to have a plan and stick to it. 
  There is one more thing—to make it easier, I've created a worksheet for 
you to print and fill out each day. I call it SuperPlan—and it's my free gift 
to you for being a newsletter subscriber. 

http://workingsmarterformacusers.us12.list-manage2.com/track/click?u=f82d40eabcbc7dc8499c11296&id=262c8aec18&e=97dac8bc8b
http://workingsmarterformacusers.us12.list-manage2.com/track/click?u=f82d40eabcbc7dc8499c11296&id=262c8aec18&e=97dac8bc8b
http://workingsmarterformacusers.us12.list-manage2.com/track/click?u=f82d40eabcbc7dc8499c11296&id=262c8aec18&e=97dac8bc8b
http://workingsmarterformacusers.us12.list-manage2.com/track/click?u=f82d40eabcbc7dc8499c11296&id=262c8aec18&e=97dac8bc8b
http://workingsmarterformacusers.us12.list-manage2.com/track/click?u=f82d40eabcbc7dc8499c11296&id=262c8aec18&e=97dac8bc8b
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http://workingsmarterformacusers.us12.list-manage1.com/track/click?u=f82d40eabcbc7dc8499c11296&id=fd2c2d3324&e=97dac8bc8b
http://workingsmarterformacusers.us12.list-manage1.com/track/click?u=f82d40eabcbc7dc8499c11296&id=fd2c2d3324&e=97dac8bc8b
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Meet SuperPlan!

SuperPlan gives you a place to organize your thoughts, identify your goals and MITs 
(Most Important Tasks) for the day, and to list the tasks you must accomplish. If you use this 
each day, I virtually guarantee you'll get more work done in less time than ever before. And, 
as a bonus, you'll find you waste far less time doing things that are unproductive.

If you'd like to give SuperPlan a try, please download your very own free copy with my 
compliments:

http://www.workingsmarterformacusers.com/free.
So give it a try if you care to—all I have to say is that it works really well for me.

Mail's Rules Rule and Here's Why
You can save tons of time and effort by using the Mail app’s Rules, which let you specify 

the conditions that trigger an action or actions.
So, for example, a rule can:

• move messages from your inbox to another mailbox
• highlight messages from specific senders
• automatically reply to or forward messages
• and much more
To create a rule, choose Mail-->Preferences and then click Rules. If you've never created a 

rule, you will see a single rule called News From Apple, which was thoughtfully included by 
the mothership so you wouldn’t have to face a blank window the first time you created a rule. 

Examine the Example Rule
Let’s take a look at this rule by double-clicking it in the list of rules or selecting it and then clicking the Edit button on the right:
This sample rule adds a blue background to any message from any of the addresses shown.

• To add another address, click the + (plus) button
• To delete an address, click the – (minus) button on the right of every condition

Make Your Own Rules
Let’s create a new rule to move new messages from a specific sender (my editor in this example) to a specific mailbox (Urgent in this example).
I began by clicking the Add Rule button, then I added two conditions to trigger the rule: From is equal to editor1@editors.com and From is 

http://workingsmarterformacusers.us12.list-manage.com/track/click?u=f82d40eabcbc7dc8499c11296&id=cbca7ad5ce&e=97dac8bc8b
http://workingsmarterformacusers.us12.list-manage.com/track/click?u=f82d40eabcbc7dc8499c11296&id=cbca7ad5ce&e=97dac8bc8b
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equal to editor2@ editors.com.

Next, I specified what to do with messages that match either condition: Move message to mailbox Urgent.
Here’s what the rule looks like:    

When I click OK, a dialog appears:

If I click Apply, my Active Rules are applied to currently selected mailboxes; if I click Don’t Apply, the Rule is saved and activated but not applied 
to selected mailboxes. From now on, this rule will move messages from either of my editors from my inbox to the Urgent mailbox.  

  You can specify more than a dozen different conditions in the dropdown menu on the left (left in the figure below), and use any of the five 
options in the dropdown menu in the middle (right in the figure below):

  The dropdown Actions menu (below all of your conditions) 
includes more than a dozen things your rule can do after it meets 
your specified conditions:

(Robert's) Order of Rules
  Everything you’ve seen about rules so far—creating a new one, and 
choosing conditions and actions—has been fairly straightforward. 
But if you have more than two rules, their order matters. You see, 
Rules are executed sequentially in the order they appear in the Rules 
window (in Mail --> Preferences). So the first rule in the list executes 
first, then the second rule, then the third, and so on. To change the 
order of your rules, just click and drag on a rule and move it up or 
down in the list.
  When you have more than a couple of rules, you may not want 
some of them to be affected by others. If that’s the case, add the Stop 
Evaluating Rules action as the final action for the rule.
  One last tip: You can duplicate any rule by selecting it and clicking the Duplicate button on the 
right of the window. Don’t forget about this feature—it’s often quicker to duplicate and modify a 
rule than to create a new one from scratch. 
  And that's all I've got this time... but, as always, I'll be back with more RealSoonNow™.

Yours Truly,

Bob "Dr. Mac" LeVitus

Reprinted with Bob LeVitus’ permission. Sign up for the Working Smarter for Mac Users NL to get Bob’s tips delivered directly to your email box.

http://www.workingsmarterformacusers.com/signupform
http://www.workingsmarterformacusers.com/signupform
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Verizon Wireless Offers More Data for More Money
by Josh Centers

First, the good news: Verizon is changing each of its data plans so that they will offer at least 30 percent more data than before. Now the bad 
news: Verizon Wireless customers who opt for the new plans will pay more. Here’s what the differences will be for each of the company’s plans:

• Small: Data allowance doubles from 1 to 2 GB; price increases from $30 to $35 per month.
• Medium: Data allowance jumps from 3 to 4 GB; price goes up from $45 to $50 per month.
• Large: Data allowance goes from 6 to 8 GB; price rises from $60 to $70 per month.
• X-Large: Data allowance grows from 12 to 16 GB; price increases from $80 to $90 per month.
• XX-Large: Data allowance climbs from 18 to 24 GB; price inches up from $100 to $110 per month.
Verizon is also matching competing carriers by introducing rollover data on all of its plans, a feature called Carryover Data. As with AT&T 

Rollover Data feature, unused data rolls over only one billing cycle before expiring. T-Mobile, in contrast, lets you accumulate rollover data for up to 
12 months.

Also, Verizon offers a new feature, called Safety 
Mode, that prevents $15 per GB overage charges by 
instead throttling data throughput to 128 Kbps after 
you run through your monthly allotment. Verizon’s 
XL and XXL plans will include this feature for free, 
but for others, it will cost an additional $5 per 
month.

The XL and XXL plans also include unlimited 
calling to Mexico and Canada, along with voice, text, 
and data while in those countries. For those on the S, 
M, and L plans, unlimited calling to Mexico and 
Canada costs $5 per month and getting talk, text, 
and data while in Mexico and Canada requires a 
$2-per-day Travel Pass plan.

Overall, these are decent changes, certainly better 
than straight price increases. However, if you’re not 
thrilled with the new plans, Verizon says that you can keep your existing plan for now.

MacNN and Tekserve Close, EveryMac and Mactracker Carry On
by Adam C. Engst

Apple celebrated its 40th anniversary in April 2016, and the Mac has been changing the world for 32 years. Our 26 years of continuous Internet 
publication means that we’ve been online longer than any other Mac periodical, but it’s not surprising that other Apple-related organizations have 
shown similar longevity.

It is thus with mixed emotion that we report two closings and two notable anniversaries. Sadly, the Mac news site MacNN, founded in 1995, has 
announced that it will no longer be publishing regularly, and the venerable New York City Apple reseller Tekserve will be closing its doors for retail 
sales and service. On the upside, particularly for those trying to establish the technical particulars of some older Mac model, the Apple spec site 
EveryMac.com celebrated its 20th anniversary on 2 July 2016 and the spec app Mactracker marked its 15th anniversary back on 14 May 2016.

On 20 June 2016, MacNN announced that it would be ceasing regular publication. Editor Charles Martin gave no specific details in his 
article about the closure, saying:

It’s kind of amazing we made it this far — only TidBITS and Macworld are older and still around — but we’ve been told we’re packing it in. 
We’ve joked before that Apple becoming a huge mainstream company is the worst thing that ever happened to us, but it’s true: there’s less need for 
an Apple-specific news site when news about Apple is plastered everywhere, on every site, all the time. This is not the sole reason why we’re having to 
give up our comfy home (and just after repainting it, too!), but it’s part of the reality we’ve been working in.

We appreciate the nod, and I remember MacNN as being a notable player in the Apple news world particularly back around 2000, when Adobe 

The Internet
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sued MacNN for publishing details about the upcoming versions of Photoshop 6.0 and ImageReady 3.0 (see “MacNN Sued by Adobe, News at 
11,” 12 June 2000). That was also around the time that Apple brought lawsuits against 25 anonymous defendants for posting trade secrets on the 
Internet (see “Apple Gets Serious About Plugging Leaks,” 7 August 2000). We wish the staff of MacNN the best.

Even sadder in some ways is the closing of Apple reseller Tekserve’s retail store on 15 August 2016. The company had been a stalwart of the 
Apple world in New York City, operating out of spaces on 23rd Street in Manhattan since 1987. It became such a fixture of the New York 
landscape that even the Carrie Bradshaw character in the “Sex and the City” TV show took her laptop there (“When was the last time you backed 
up?”). YouTube Link: Did you back up your data? "Umm I don't do that"

Unlike MacNN, which was presumably struggling against the near-infinite competition for online attention and a market that no longer favors 
advertising-supported publications, Tekserve’s competitive problems were more physical. Apple has six stores in Manhattan alone, one not far from 
Tekserve. Plus, there’s a Best Buy nearby and all the usual online options. With rising rents, Tekserve’s retail operation simply didn’t make business 
sense anymore. At least Tekserve isn’t going away entirely; the company will continue to provide corporate sales and professional services.

Although it’s clear that Apple’s rising tide does not float all boats, other sites and apps continue apace. EveryMac.com, a Web site devoted to 
documenting detailed specs about Apple products, has been around for 20 years now, an impressive feat on the part of founder Brock Kyle. 
EveryMac.com provides details on all Macs from the vintage 68000 and PowerPC lines to the latest Intel models, and it covers all of Apple’s mobile 
devices, too. It’s a treasure trove of information, featuring the original prices of Macs around the world, specs on the largely forgotten Mac clones, and 
Q&As for many Mac models that go beyond mere specs. The site is still evolving too — last month, EveryMac.com launched a new version of its 
Ultimate Mac Lookup feature that adds thousands of identifier specific tips and details.

Finally, though it’s the baby of this roundup, I also wanted to acknowledge the efforts of Ian Page, whose donation-ware Mactracker application 
has been a must-have for over 15 years now. First developed in 2001 for both Mac OS 9 and Mac OS X, Mactracker has evolved over time, adding 
an iOS version in 2009. Its internal database has grown too, from information on 243 models in version 1.0 to detailed specs on over 700 models 
today.

Mactracker and EveryMac.com are a boon to support techs, journalists, and anyone who needs to unearth specific characteristics of older Mac or 
other Apple hardware. Thanks to Brock Kyle and Ian Page for keeping them going all these years!

Sling TV, a Cord Cutter’s Delight, Arrives on Apple TV
by Julio Ojeda-Zapata 

For cord cutters seeking to ditch ever-costlier cable and satellite TV, Sling TV is a compelling alternative, which I first wrote about in “FunBITS: 
Sling TV Is Made for Cord Cutters” (20 February 2015). It’s a cable-style service, with enticing and affordable packages of leading networks, but 
delivered online, with no need to set up a special box.

I have at times been tempted to jettison my Comcast TV service largely on the strength of Sling TV’s offerings. I’ve hesitated for a number of 
reasons, not least of which is that I could not access Sling TV on an Apple TV, my preferred video-streaming box.

Now that barrier has been removed. Sling TV has finally released an app for the fourth-generation Apple TV to complement its iOS and Mac 
apps. Sling is also offering a 32 GB Apple TV for $89, compared to the usual $149 price tag, for those who prepay three months of Sling TV.

Sling TV’s new Apple TV interface is pretty good. I don’t think it quite matches up to the Comcast X1 interface, another reason I’ve hesitated to 
cut the cord, but Sling has made great strides in usability since I last reviewed it.

Sling Content -- Sling also has significantly expanded its content offerings. It once had only 20 or so channels, and that number is now up to 
about 100.

The company largely divides this lineup between two bundles, the $25-per-month Sling Blue, and the $20-per-month Sling Orange. The two 
have a good deal of overlap, but also differences.

Blue is a “multi-stream” service – meaning you can watch on up to three devices at once – with 42 channels, including new ones like USA, Bravo, 
and Syfy. It also includes local NBC stations in some markets, with more markets to come eventually.

Orange is a single-stream service with 29 channels, including new addition BBC America. Sling also offers an option to combine Blue and Orange 
(Sling Gray?) for a single $40-per-month fee.

If that’s not enough, you can add themed bundles, each $5, that focus on sports, children’s shows, comedy, world news (including recent addition 
BBC World Service), and more. HBO and Cinemax each cost an additional $15 and $10, respectively.

Sling also emphasizes Spanish-language programming, and the company has just augmented its longstanding “Best of Spanish TV” bundle with a 
“Caribe” bundle focused on Cuba and Puerto Rico, along with a “Colombia Extra” bundle. Such add-ons also cost $5 apiece, but Spanish speakers 
who want only this content, and nothing en inglés can also purchase them for $10 entirely on their own.

Interface for the Live and the Canned -- Sling’s vast program options are a blend of live and on-demand content, and various networks have 
made different decisions as to what ratio of live and canned shows they make available.

Accordingly, Sling TV’s Apple TV interface attempts to cluster its content into corresponding sections. It doesn’t do this perfectly, but making 
sense of it all isn’t hard. To get started, you access the main menu by swiping downward from the top of the TV screen.

http://tidbits.com/article/5977
http://tidbits.com/article/5977
http://tidbits.com/article/5977
http://tidbits.com/article/5977
http://tidbits.com/article/6070
http://tidbits.com/article/6070
http://www.nytimes.com/2016/06/30/nyregion/tekserve-precursor-to-the-apple-store-to-close-after-29-years.html?_r=0
http://www.nytimes.com/2016/06/30/nyregion/tekserve-precursor-to-the-apple-store-to-close-after-29-years.html?_r=0
http://www.youtube.com/watch?v=YWSZJXhOvBw
http://www.youtube.com/watch?v=YWSZJXhOvBw
https://www.youtube.com/watch?v=YWSZJXhOvBw
https://www.youtube.com/watch?v=YWSZJXhOvBw
http://www.tekserve.com/
http://www.tekserve.com/
http://www.everymac.com/
http://www.everymac.com/
http://www.everymac.com/ultimate-mac-lookup/
http://www.everymac.com/ultimate-mac-lookup/
https://mactracker.ca/
https://mactracker.ca/
https://mactracker.ca/15-years/
https://mactracker.ca/15-years/
http://tidbits.com/article/16594
http://tidbits.com/article/16594
https://www.sling.com/
https://www.sling.com/
http://tidbits.com/article/15430
http://tidbits.com/article/15430
http://tidbits.com/article/15430
http://tidbits.com/article/15430
https://itunes.apple.com/us/app/sling-tv-live-and-on-demand/id945077360?mt=8&at=10l5PW
https://itunes.apple.com/us/app/sling-tv-live-and-on-demand/id945077360?mt=8&at=10l5PW
https://www.sling.com/devices
https://www.sling.com/devices
https://www.sling.com/devices/appletv
https://www.sling.com/devices/appletv
https://customer.xfinity.com/help-and-support/cable-tv/xfinity-tv-on-the-x1-platform/
https://customer.xfinity.com/help-and-support/cable-tv/xfinity-tv-on-the-x1-platform/
http://news.sling.com/press-release/company/sling-tv-debuts-new-single-stream-and-multi-stream-services-launches-nbc-usa
http://news.sling.com/press-release/company/sling-tv-debuts-new-single-stream-and-multi-stream-services-launches-nbc-usa
http://news.sling.com/sites/sling.newshq.businesswire.com/files/doc_library/file/Channel_Comparison_Chart.pdf
http://news.sling.com/sites/sling.newshq.businesswire.com/files/doc_library/file/Channel_Comparison_Chart.pdf
http://blog.sling.com/announcements/nbc-networks-now-available-on-new-multi-stream-service-sling-blue/
http://blog.sling.com/announcements/nbc-networks-now-available-on-new-multi-stream-service-sling-blue/
http://blog.sling.com/announcements/bbc-america-and-bbc-world-news-now-on-sling-tv/
http://blog.sling.com/announcements/bbc-america-and-bbc-world-news-now-on-sling-tv/
http://news.sling.com/press-release/marketing/sling-latino-launches-new-caribe-pack-nbcuniverso-joins-best-spanish-tv
http://news.sling.com/press-release/marketing/sling-latino-launches-new-caribe-pack-nbcuniverso-joins-best-spanish-tv
http://news.sling.com/press-release/marketing/sling-latino-launches-new-caribe-pack-nbcuniverso-joins-best-spanish-tv
http://news.sling.com/press-release/marketing/sling-latino-launches-new-caribe-pack-nbcuniverso-joins-best-spanish-tv


25
One menu option, dubbed Guide, is the busiest and a bit tricky to navigate 

by way of the Apple TV’s touch-based Siri Remote. All available channels 
appear in a strip near the top. That’s a lot of sideways thumb scrolling to find 
the channel you want, but you can refine selections by criteria – like sports, 
news, or family – via a menu underneath the channel strip.

Once you select a channel, a host of options appear below. These vary by 
channel. In some cases, you can select live content and see a schedule of 
upcoming live airings. In other cases – such as HBO and Cinemax – there’s a 

wealth of on-demand content that you can watch at any time. It 
includes movies and TV shows like HBO’s “Silicon Valley” and 
“Game of Thrones,” for those who like Netflix-style binge 
watching.
  But, again, Sling organizes its content into horizontal strips that 
require endless sideways scrolling. It is torture, for instance, to 
move rightward alphabetically through dozens of films available 
from HBO alone.
  Elsewhere in the Sling TV interface, you can pick the My TV 

option to see your partially viewed programs and content you’ve 
favorited for later viewing. Faved offerings include most-watched shows, 
on-demand movies, and entire channels for a customized and 
convenient personal menu that bypasses that awkward main channel 
strip.

On Now shows programs that are currently playing live.

  A redesigned Mini Guide lets you browse through available live content 
without interrupting what you are currently watching. It takes up less 
space than the previous Mini Guide, according to Sling. To access the 
Mini Guide on the Apple TV, swipe upward from the bottom of the 
screen.

Sling TV has a search engine, which you can harness either via 
an on-screen alphabet interface or by using voice commands 
spoken to the Siri Remote. The app also provides simple parental 
controls that let parents prevent access to particular program ratings 
— along with unrated content.

Sling’s Apple TV interface is different from that on the iPad and 
the Mac, though not exponentially better in terms of interface 
design. The Apple TV app seems more reliable, though; I’ve 
struggled to pull up content like HBO’s “Silicon Valley” on my 
iPad, but that has been far less of an issue on the Apple TV. 
However, the Mac version has always performed reliably for me.
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Still, Sling said the redesigned interface debuting on the Apple TV will eventually 
become its standard look and will migrate to other platforms in coming months. 
As I was finishing this article, it had already debuted on the Roku.
 SlingTV provides apps for a variety of other platforms – like Google 
Chromecast and Amazon Fire TV streaming devices. This broad platform 
compatibility makes Sling TV an enticing option for those who are tempted to 
cut the cord amid skyrocketing cable and satellite bills.

ExtraBITS
Your Wireless Keyboard May Be Betraying You -- Bastille, a cybersecurity company, has shown that hackers can easily intercept transmissions 
from eight non-Bluetooth wireless keyboards. Experts demonstrated how a $40 radio transponder combined with a $50 antenna could eavesdrop 
on the signals of budget wireless keyboards from Anker, EagleTec, General Electric, HP, Insignia, Kensington, Radio Shack, and Toshiba. 
Bluetooth and wired keyboards, however, are not vulnerable to the methods used in this attack. It’s a reason to avoid wireless keyboards that depend 
on proprietary transmission systems.

Apple Casting Its Own Reality Show -- Apple has issued an open casting call for “Planet of the Apps,” the company’s upcoming reality series 
about app developers. Applications are being accepted from developers through 26 August 2016; applicants must have an iOS, macOS, tvOS, or 
watchOS app in a functional state by 21 October 2016, with filming to take place in Los Angeles from late 2016 through early 2017. The producers 
are promising “hands-on guidance from some of the most influential experts in the tech community, featured placement on the App Store, and 
funding from top-tier VCs.” We don’t yet know the format of the show, which raises important questions. Will we see lots of geeks talking into their 
iPhone FaceTime cameras while “working” at Starbucks? Will there be judges making catty remarks about coding styles? Will the snarky QA 
engineer get voted off the team? Stay tuned…

Apple Music Scores “Carpool Karaoke” Series -- First, the news broke about Apple’s “Planet of the Apps” TV show, and now the company is 
continuing its foray into original content by nabbing CBS’s upcoming “Carpool Karaoke” series. “Carpool Karaoke” is a spinoff of the popular “The 
Late Late Show with James Corden” bit, in which he drives celebrities around as they sing songs. Although it doesn’t sound as if Corden will host 
the new show, it is, nonetheless, a big “get” for Apple Music.

Video on Apple Music No Longer Counts Against T-Mobile Data Caps -- While T-Mobile users have been able to stream music from Apple 
Music for the past year without it counting against cellular data caps, the carrier has now added Apple Music to its Binge On program, meaning that 
video from Apple Music will no longer count against the caps. This exemption includes music videos, as well as future video content on Apple 
Music, such as the upcoming “Carpool Karaoke” series from CBS.

Why Your Phone’s Battery Meter Is Wrong -- Has your iPhone ever died, even though it claimed to have charge left? The Wirecutter goes over 
the complex reasons why mobile device battery meters are often so inaccurate. The article describes the different variables that go into computing 
remaining battery charge and concludes that battery meters can, at best, provide only a guess of the remaining charge.

Lightroom for iOS 2.4 Changes Mobile Photo Workflow -- Lightroom for iOS 2.4 adds two significant features to the mobile photo editing app 
for iPad and iPhone: support for raw format images and local selections for adjusting specific areas of a photo. This means photographers who shoot 
in raw can import, edit, and sync their photos between mobile and desktop Lightroom libraries without annoying workarounds.

Apple Simplifies Relationship between Apple Music and iTunes Match -- At Macworld, Kirk McElhearn describes changes coming to Apple 
Music that make deciding between it and iTunes Match much easier. Apple Music will now match tracks using acoustic fingerprinting instead of 
track metadata (as iTunes Match already does), and it will no longer apply DRM to matched tracks you download to other devices. Kirk explains 
the differences in detail with recommendations for those who have subscribed to both services.

First Look at Scrivener for iOS -- One of the premiere tools for creative writers, Literature & Latte’s Scrivener, is breaking away from the desktop 
with a powerful mobile version.
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HOW TO FIND US
General meeting:
SMMUG General Meetings are held on the SECOND Monday of 
each month at Fire Station 14 located at 1875 Dublin Blvd (at the 
intersection of North Academy and Dublin). 

Directions:
From Academy, go east on Dublin and then turn right on 
the very first street. There is parking on the west and south 
sides of the Fire Station (with additional parking located to 
the north and further west of the Fire Station). The entrance 
is on the west side of the building.

Smoking is not permitted on the premises. 

Sig meeting:
The SIG Meetings are held on the SECOND Saturday of each month at Fire Station #18’s meeting room - located at: 6830 Hadler View 
[the fire station is behind Walgreens]. 

Directions:
#1) Take I-25 to Garden of the Gods Rd (head west), turn right on Centennial, left on Flying W Ranch Rd., right on Hadler View.
#2) (This route is bumpier and probably not the best for winter travel) Take I-25 to E. Woodman/W. Rockrimmon Blvd., turn right on Vindicator 
(at the Safeway intersection), and then right on Hadler View.



28

Membership Application Form
Membership entitles you to access to our online forums, participation in prize drawings, and access to the 
bargains in the members area of the SMMUG website at www. smmug.org. SMMUG renewal membership dues 
($25) apply to the calendar year and are paid each December for the following year. Use the following table for 
NEW MEMBERSHIP ONLY:

 JAN 1 to MAR 31 - $25.00  APR 1 to JUN 30 - $21.00
 JUL 1 to SEPT 30 - $14.00  OCT 1 to DEC 31 - $7.00

Please Print Clearly!     Today’s Date 

Name
 Street Address

 City/State/ZIP
 Home Telephone

 E-mail Address
Have you previously been a member of SMMUG?
How did you learn about SMMUG?

Make your check payable to:  SMMUG  
Then mail or give this form and your check to:

SMMUG, Inc. 
Skip Mundy, Treasurer   
PO Box 62741 
Colorado Springs, CO   80962 

Please make an online account for me.
User Name _______________

Don’t make an online account for me. 
I do not want one or I already have 

Business Telephone 

About Us

The Silicon Mountain Macintosh User Group, Inc. (a nonprofit educational corporation) was formed in Colorado Springs, 
Colorado in 1985, and is one of the oldest Macintosh User Groups in the United States. SMMUG, Inc. is dedicated to helping 
members enjoy and learn about their Macintosh computer, iPhone and iPad devices.

Club membership is open to everyone and you are cordially invited to visit our free monthly General Meeting on the First 
Tuesday of each month, at 7:00 PM. For those new to the Macintosh, we have a Question & Answer session at 6:00 PM, where 
our collective expertise can help answer your questions. 

All members receive a monthly newsletter, published on our web site, see great reviews of software and hardware, or can 
participate in the monthly door prize drawing. Each member gets one vote during annual Officer Elections. No corporate 
memberships are granted.

Our officers are volunteers and receive no pay. All funds raised are used for the cost of operating the club and its meetings.
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